YASKAWA Electric Corporation
Machine Controller MP2000 Series

Serial Driver

Supported version TOP Design Studio V1.0 or higher {Rl

TOP

"
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We would like to thank our customers for using M2I's "Touch

Operation Panel (M2] TOP) Series". Read this manual and familiarize
yourself with the connection method and procedures of the "TOP and

external device”.
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each device, cables, and configurable systems.
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Select a TOP model and an external device.
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Describes how to set the TOP communication.
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6. Supported addresses Page 15

Refer to this section to check the addresses which can

communicate with an external device.
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1. System configuration
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The system configuration of TOP and "YASKAWA Electric Corporation — MP2000 Series Serial” is as follows.

H MEMOBUS

Communication
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2. External device selection

H Select a TOP model and a port, and then select an external device.

Select Device H
PLC select [COM1]
Filter : |[AII] v‘ Search : I:I

@ Model (O Vendor
Vendor Model

MZ2I Corporation @D & Mpa00
MITSUBISHI Electric Corporation :‘ Mp2000

OMRON Industrial Automation

LS Industrial Systems

MODBUS Organization

SIEMENS AG.

Rockwell Automation

GE Fanuc Automation
PAMASONIC Electric Works
YOKOGAWA Electric Corporation

Schneider Electric Industries

KDT Systems
RS Automation %
4_Back | B Next *® Cancel
Select Device n
PLC Setting[ Mp2000 ]
Interface : | Serial ~
Protocol : | MEMOBUS RTU ~ Comm Manual
String Save Mode : |First LH HL Change
[ use Redundancy
AND -
Primary Option
Timeout msec
Send Wait msec
Retry 5 =
Slave Address No DI
@ Back + OK * Cancel
Settings Contents
TOP Model Check the TOP display and process to select the touch model.
External device | Vendor Select the vendor of the external device to be connected to TOP.

Please select "YASKAWA Electric Corporation".

PLC Select an external device to connect to TOP.

| Interface | Protocol
Mp2000 Serial Set Users

Supported Protocol
MEMOBUS ASCIl | MEMOBUS RTU | MP Extension

Please check the system configuration in Chapter 1 to see if the external device you want to

connect is a model whose system can be configured.
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3. TOP communication setting
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The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that

of the external device.

3.1 Communication setting in TOP Design Studio

(1) Communication interface setting

M [ Project > Project properties > TOP settings] — [Project option > Check "Use HMI settings” > Edit > Serial ]

— Set the TOP communication interface in TOP Design Studio.

Project Optien

- Change HMIH]
T TOF Setting
-

T1520%
~ @ Option Module Setting
{4 FieldBus (0)
L. RFID ()
v i Device Setting
g8 COM1 (1)
! i.ggm PLC1:Mp2000 [1]
Lrm COM2 (0)
=% COM3 (0)
W Ethernet (0)
(1@ Wireless (0)
i USBDevice (0)

' AddPLC ] | TR Change PLCIC)

Date [ Time Sync.

Project Option

Use HMI Setup

Screen Option

Screen Change

HmiSetup

E3 Delete PLCID]

Unit Convert

Global Lock & Touch

Project Style  Splash

Initialization | Edit |

PLC Buffer Sync.

Project Setting
HMIDisable=0

Project Name=New project
Start Mode=Menu

Start Screen No. =1

Latch Use=0

Latch Set=0~0
Communication Error Message =0
USBErrorMessage =0
StorageErrorMessage=1
DatabaseMessage=1

~

Control Panel

System m[}evices :uaService _'—'"'_'Dption

s Serial *
- >
I l | Serial Port: | COMI =
FLC Security DatesTime Signal Level
(@) R5-232C O Rs-42204) O Rs-485(2)
. Baud Rate: 19200 =
.- 3 —
L it
Data Bit: 3 ~
Et hernet Serial HOM | .
Stop Bit: |1 -
i \ Parity Bit: Ewen M
= ‘\\ Flow: [ff
. Ping
Diagnost ic File Ping Auto Search  Loopback Test
Manager
Cance|
Items TOP External device Remarks
Signal Level (port) RS-232C
RS-232C RS-422 RS-485
RS-422/485
Baud Rate 19200
Data Bit 8
Stop Bit 1
Parity Bit Even

* The above settings are examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [ Project > Project properties > PLC settings > COM > "PLC1 : Mp2000"]
— Set the options of the communication driver of MP2000 Series Serial in TOP Design Studio.
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Project Option

- Change HMIH]

“ AddPLC[A] | THITal Change PLCIC)

m Delete PLC[D]

TOP Setting
-3 5YS : RD1520%
#8 Option Module Setting
- FieldBus (0)
i L. RFID ()
W - Device Setting

W

g COM3 (0)
- Ethernet (0)
Wireless (0)

: COM1 (1
i Lwe PLC1: Mp2000 [1]
gt

PLC Setting[ Mp2000 ]
Alizs Name : [PLC1

Interface : |Serial ~

Protocol : | MEMOBUS RTU ~
String Save Mode : (First LH HL Change

[ use Redundancy
AND ~

)]
4

Primary Option

Timeout

300 < msec
Send Wait msec
Retry 5 z

Slave Address No

Comm Manual

Apply Close
Items Settings Remarks
Interface Select “Serial”. Refer to "2. External
Protocol Select the serial communication protocol between the TOP and an external device.

device selection”.

Communication option items when selecting MEMOBUS

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device

and sending the next command request.

Slave Address No

Enter the prefix number of an external device (Slave).

Communication option items when selecting MP Extension

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device

and sending the next command request.

Station No

Enter the prefix of an external device.
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3.2. Communication setting in TOP
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* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked.

W Touch the top of the TOP screen and drag it down. Touch “EXIT" in the pop-up window to go to the main screen.

(1) Communication interface setting

M [ Main screen > Con

trol panel > Serial ]

(i

Ethernet Serial
J—
==
-

Diagnost ic File
Manager

[System]

Panel

Conitrol

- Serial

Serial Port: lCDhﬂ

Signal Level
i RS-232C () RS-422(4) ) BS-485(2)

Baud Rate: | 19200
Data Bit: |8

Parity Bit: | Even
Flow: l Ofi f

|

|
Stop Bit: | 1 ~

|

|

lAuto Searchl [Loopback Test]

 Apply | Cancel |

Close F

Items TOP External device Remarks
Signal Level (port) RS-232C

RS-232C RS-422 RS-485

RS-422/485

Baud Rate 19200
Data Bit 8
Stop Bit 1
Parity Bit Even

* The above settings are setting

examples recommended by the company.

Items Description

Signal Level Select the serial communication method between the TOP and an external device.

Baud Rate Select the serial communication speed between the TOP and an external device.

Data Bit Select the serial communication data bit between the TOP and an external device.

Stop Bit Select the serial communication stop bit between the TOP and an external device.

Parity Bit Select the serial communication parity bit check method between the TOP and an external device.
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(2) Communication option setting

M [ Main screen > Control panel > PLC ]

Run

YNC
Yiewer

Screen
shot

ERI2 e B X
Touch Qperation Panel

ks
o o) PLC

-

@ Systq Driver(COMI)  PLCI(Hp2000) '~ |
T——1 | Interface | Serial R
! | Protocol | MEMOBUS RTU R
PLC Timeout 300 [ msec
Send Wait msec
] | = 5B
=)
S Slave Adc =
Diagnost ic
[System l Diagnostic

| 4eply || Cancel |

E—

Items Settings Remarks
Interface Select “Serial”. Refer to "2. External
Protocol Select the serial communication protocol between the TOP and an external device. device selection”.

Communication option

items when selecting MEMOBUS

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device

and sending the next command request.

Slave Address No

Enter the prefix number of an external device (Slave).

Communication option

items when selecting MP Extension

TimeOut (ms)

Set the time for the TOP to wait for a response from an external device.

SendWait (ms)

Set the waiting time between TOP's receiving a response from an external device

and sending the next command request.

Station No

Enter the prefix of an external device.
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3.3 Communication diagnostics

B Check the interface setting status between the TOP and an external device.
- Touch the top of the TOP screen and drag it down. Touch "EXIT" in the pop-up window to go to the main screen.
- Check if the COM port settings you want to use in [Control Panel > Serial] are the same as those of the external device.

W Diagnosis of whether the port communication is normal or not
- Touch “Communication diagnostics” in [Control Panel > PLC ].

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status.

oK Communication setting normal

Time Out Error Communication setting abnormal

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet)

B Communication diagnostics sheet

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below.

Items Contents Check Remarks
System How to connect the system OK NG ) )
' . ) 1. System configuration
configuration Connection cable name oK NG
TOP Version information oK NG
Port in use OK NG
Driver name OK NG
Other detailed settings oK NG
Relative prefix Project setting oK NG
Communication 2. External device selection
) ) oK NG . .
diagnostics 3. Communication setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
External device CPU name oK NG
Communication port name (module name) OK NG
Protocol (mode) OK NG
Setup Prefix oK NG
Other detailed settings OK NG . .
4. External device setting
Serial Parameter Transmission
oK NG
Speed
Data Bit oK NG
Stop Bit oK NG
Parity Bit oK NG
Check address range 6. Supported addresses
oK NG (For details, please refer to the PLC
vendor's manual.)
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4. External device setting

Set as below using “MP Series” Ladder Software “MPE720". For more detailed setting method than that described in this example,

refer to the PLC user manual.

- In case of setting "Automatically Reception” of “Procedure II" to "Enable” in the setting procedure
below, it is possible to connect without “"Procedure II".

— The example of “Procedure II: Ladder Program” is an example of communication setting for one port

on the external device side. In case of simultaneous communication of multiple ports, a separate

ladder program is required. Please contact the manufactorer for details.

[ ] Operation I : "PC and PLC connection method" : set communications as follows(Operation II, Operation II), but before
connect PC and PLC.

1. Run “Communication Manager” program.

( Path : Start — Program — "YE_Applications” — “Communication Manager” )

2. Run "Logical Port Setting" to set the port type and details.

( Path : File — Setting...)

3. After PC and PLC are connected, save, and follow below operation.

[ ] Operation II : "MPE720" Create Project : (root) > [Group Folder] > [Order Folder] > [Controller Folder] Register

. . . - t
1. To register the device you want to use in "MPE720", follow “[Group Folder] > %&DD{JEWPHJ
" - (3 TESTI
[Order Folder] > [Controller Folder]” path. [ MP_300
(Caution) In the "MPE720" left project window, Right—Click, and follow the parent = E[g%‘H o Fold
+ eqgisier Folder
path through the [New] entry. +-{] Database
=-[Z1 Definition Faolder
2.Register the Controller Type for the device you wish to use in the Controller pplication Infarmation Setting
Data Trace
Configuration window, which appears when registering a new [Controller Folder] Failures Definition
Module Configuration
3. Double-click the newly registered [Controller Folder] to bring up the [Log on to Scan Time Setting
. . Systern Configuration
the controller] window and enter "User Name" and "Password" to form project 4.3 Programs
folders as shown on the left. +(Q Table Data Folder

H Operation III : “Communication Setting” : [Engineering Manager] — [Module Configuration] window
4. Double-click [Definition Folder] - [Module Configuration] to display the [Engineering Manager] — [Module Configuration] window.
5. Register the [Module Type] of the corresponding [Rack] — [Slot] position in the [Module Configuration] window.

6. Double-click the corresponding [Slot] area to display the setting window. Matters to be set are as follows.

CIR#01 ]C|H#92| CIR#03 | Items Settings Remarks
Transmission Protocol MEMOBUS Fixed
Teansmission Protocal | MEMOBTS Master/Slave Slave Fixed
Device Address 1 Set Users
Master! ave Have - :
Serial I/F RS-232 User setting *Note 1)
Device fddr U] Master=0,Slave=163 . .
e Adte =i (Master=D Slave=13) Transmission Mode RTU User setting *Note 2)
semellils B v Data Length 8Bit Set Users
Transmission Mode RIT < Parity even Set Users
Diata Length 8Eit - Stop Bit 1Stop Set Users
Paty aven - Baud Rate 19.2K Set Users
Stop Bit m Sending : : DFsabIe Set Users'
,—_| Automatically Reception Disable User setting *Note 3)
192K - . .
Band Rate Slave I/F Register Settings — Set Users
Sending (¥ Disahle *Note 1) Select the communication method of the external device (RS-
" Enble _|:| {1~ 100ms) 232C/RS-422/RS-485).
futornaticaly Receotion @8 Dissble ¢ Enable *Note 2) Select the communication mode (ASCII/RTU) you want to use.
STave IF Register Settings HesdBEG WD Size *Note 3) When setting Disable, you must reg'lster a separz?te Ladder Software.
Readt of fnput Relap ’W ’W If enablgd, ‘a separate Ladder Software is not required. However, the
Readout of It Eegister ’W ’W ;;)rrl;munlcatu.)n spe:d may b-e SIO\:\/./IP : .
Readout ! Waite-nof Hold Regiter ’m 276 elect [ Serial I/F : RS- ] [ Transmission Protocol: ].

Select [Automatically Reception: Disable 1.

TJrite - in vadth of Coil/Hold Beqist -| MTI00000
s el Procedure IV does not proceed.

HI [T
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l Operation IV : Ladder Program : MSG-RCV function

7. Register the [MSG-RCV] function ( [Instruction Pallete] menu — [System] tab ) on the [Ladder Works] Software. Refer to the

example below. For more detailed setting method, refer to the Ladder Software manual.
Cima scan at powear ON

SBOODOO3
- L Sl SB03
IFON H scan: SB01 At power ON, set the param-
eters in fe first scan,
FOR FO0 TO 3 EY1
—o —DWOD00i DW register dear
FEMD
00000 —DWOODDE | Coil offset setting
00000 —DWODD0E | Relay offset setting
00000 SOWO0D010 | Input offsat setfing
— 00000 +DW00011 | Holding register offsat setting
L] SDWODD12 | Wite rangs lower byles
— 32767 —DWO0D13 | Write rangs higher byles
Q000D —DWDD024 | Nomal pulse counder dear
[ 00000 SDWO0DDI2Z5 | Emor counter clear
[ 00000 —DWODD14 | Sysiem clear
IEMD!
Command MEG-RCV Executing Sands a Receive Message
SBEODNHM DEOOIZI0 command from connedtion
| EXECUTE  BUSY O ST
intermupt Mommal completion | The executing coll tums ON when
SBOO0004 DEIOIZ11 the GPU recenes the command.
|/ ABORT COMPLETE O

Abnomal compl efion The nomeal complafion or abnor-
DEIOO212 mal completion coill tums ON at

— ooone ——Pf) DEV-TYP --E_R_RQB_..__, O recaption complafion.
— 00007 —————»{ PRO-TYP

-

1 MEMOBLIS communicafions
— 00001 ————f{| CIR-NO I Lina Mo.1
— 00001 —— ol CH-NO ¥ Channal Mo, 1
SEND PARAM DEV-TYP
DADOO0OD Set the device
fype.
. 215IF=1
218IF=6
_ Tums OM command message has
Fart an the CPU=E been recsived normally and re-
Marmal countar sponss messags has besn trans-
mitted nomally.
|: NG DWODD24 :| MNormal pulse counter addad
Abnormal complbetion
DBOO0212
— Ended by a transmission emor
IFCM
Emor counfer
INC  DWOD025 Emor pulse counter addad
— OV D000 WDWODDZE Procassing result stonsd
— CAWODH0T DWODo27 Sdatus stoned
— CAW 00002 «DWODDZS Remats ST# stored
— DWW —DWODD2a FC stored
— CAW D005 «DWODDE0 Diata address stored
— CAWODO0E «DWODD31 Data sze stored
— CAW D007 «DWWDDOE2 Remats CP# stored
IEMD ——p -
SBFF'C':'D"' SHEE-NEI Connecting Port | Address
N s Port 1 SB006940 / SB006941
SHO0NGM SH006941 Port 2 SB006950 / SB006951
11 o
DEMD
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TOP 225 -
5. Cable table

This chapter introduces a cable diagram for normal communication between the TOP and the corresponding device.
(The cable diagram described in this chapter may differ from the recommendations of “YASKAWA Electric Corporation”.)

5.1. Cable table 1

m RS-232C (1:1 connection)

COM External device
Pin Signal Pin Cable connection Pin Signal Pin
arrangement*Note 1) name number number name arrangement*Note 1)
1 5 CD 1 1 FG 1 5
(@ o) RD 2 2 SD (@ @)
g g ) 3 3 RD g g
DTR 4 4 RS
Based on Based on
- SG 5 5 CS L
communication communication
cable connector DSR 6 6 N/C cable connector
RTS 7 7 SG
front, front,
D-SUB 9 Pin male c1s 8 8 N/C D-SUB 9 Pin male
(male, convex) 9 9 N/C (male, convex)

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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5.2. Cable table 2

W RS-422 (1:1 connection)

CcoOM External device
Pin Signal Pin Cable connection Pin Signal Pin
arrangement Note 1) name number number name arrangementNote 1)
1 5 RDA 1 1 TX+
(@ o) 2 2 TX-
g S 3 3 RX+ Based on
Based on RDB 4 4 RX- communication
communication > 7 RXR cable connector
cable connector SDA 6 1 TXR front,
front, I 14 GND MR-14 (Plug)
D-SUB 9 Pin male 8
(male, convex) SDB 9

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

CoM External device
Pin Signal Pin Cable connection Pin Signal Pin
arrangementNote 1) name number number name arrangement-Note 1)
1 5 RDA 1 1 TX+
(@ o) 2 2 TX-
g S 3 3 RX+ Based on
Based on RDB 4 4 RX- communication
communication > 6 RX- cable connector
cable connector SDA 6 8 X+ front,
front, l 9 TX- MR-14 (Plug)
D-SUB 9 Pin male 8 10 RX+
(male, convex) SDB 9 14 GND

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.

W RS-485 (1:1 connection)

coOM External device
. Signal Cable connection Pin Signal Pin
Pin arrangement
name number name arrangementNote 1)
+ 1 TX+
T - 2 TX-
O SG 3 RX+ Based on
L1 SG 4 RX- communication
‘ | 6 RX- cable connector
+ 8 X+ front,
O 9 TX- MR-8 (Plug)
L= || 10 RX+
14 GND

*Note 1) The pin arrangement is as seen from the connecting side of the cable connection connector.
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B RS-422 1 : N connection - Refer to 1:1 connection to connect in the following method.

TOP
Signal name
RDA
RDB
SDA
SDB
SG

Cable connection and signal

direction

External device

Signal name

SDA

TO,

Cable connection and signal

direction

ERI2 e B X
Touch Qperation Panel

External device

Signal name

SDB

SDA

RDA

SDB

RDB

RDA

SG

RDB

B RS-485 1: N connection - Refer to 1:1 connection to connect in the following method.

TOP
Signal name
RDA
RDB
SDA
SDB
SG

(Caution) In case of 1:N connection, short the pin arrangement of (1) and (2) items out of 14 pins for terminating devices.

Cable connection and signal

direction

External device

Cable connection and signal
direction

SG

External device

L

Signal name
1 TX+
2 TX-
6 RX-
10 RX+
14 GND

External device connection manual for TOP Design Studio
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6. Supported addresses
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The devices available in TOP are as follows:

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the

address range supported by the device you want to use.

M Extended Memobus

Device Bit Address Word Address 32bit Remarks
MB Coil MBO000000 ~ MB65535F MB00000 ~ MB65535 L/H
B Discrete Input IBOO00O ~ IBFFFFF IBOO0OO ~ IBFFFF *Note 1)
W Input Register - IW0000 ~ IWFFFF *Note 1)
MW Holding Register - MWO00000 ~ MW65535
*Note 1) Cannot be written
Wl MP Extension
Device Bit Address Word Address 32bit Remarks
SB ) SB00000 ~ SB8191F SBO000 ~ SB8191 L/H
System Register
SW SWO0000.0 ~ SW8191.F SW0000 ~ SW8191
B IBOO00O ~ IBFFFFF IBO0O0OO ~ IBFFFF
Input Register
W IW0000.0 ~ IWFFFF.F IW0000 ~ IWFFFF
OB OB00000 ~ OBFFFFF OB0000 ~ OBFFFF *Note 1)
Output Register RPN
ow OW0000.0 ~ OWFFFF.F OWO0000 ~ OWFFFF *Note 1)
MB MBO000000 ~ MB65535F MB00000 ~ MB65535
Data Register
MW MWO00000.0 ~ MW65535.F MWO00000 ~ MW65535
*Note 1) Cannot be written
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